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1: Introduction 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The IMPAX Time Saver System (TSS) Viewing System is a software system that allows 
viewing and collecting data from a network of IMPAX TSS monitors. It runs on a computer 
connected to the network of TSS units, and displays real-time data from the TSS units and the 
machines they are monitoring. It can present summary data for all machines, and also present 
detailed information on each machine. All data collected by TSS monitors can be viewed 
through the Viewing System, and data can also be periodically saved to disk, for later reporting 
and analysis, or for importing into other databases. This manual describes how to install, set up, 
and use the features of the IMPAX TSS Viewing System. 
 
The IMPAX TSS Viewing System software consists of a Microsoft Excel workbook, running in 
tandem with a data server program, DSDataServer. The data server connects to the TSS monitors 
to request and send data, and the Excel workbook provides the user interface to view and analyze 
all machine data. Using Excel, data may also be periodically saved to disk for analysis. 
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User Notice 
 
This IMPAX TSS System contains valuable confidential and proprietary information of Process 
Technologies Group, Inc. No part of the installed software, screen layouts, or other materials 
may be transmitted, distributed, copied, photocopied, scanned, reproduced, translated or 
otherwise duplicated on any medium without written consent of the owner.  If such consent is 
given, the same confidential, proprietary and/or copyright notices must be affixed to any 
permitted copies as were affixed to the original. Use of the software programs contained herein 
this IMPAX TSS SYSTEM are subject to applicable license agreements, usage guidelines, and 
non-disclosure agreements.  Unless specifically otherwise agreed, all rights, title, and interest to 
the software programs, screen layouts, and other material contained herein remain with Process 
Technologies Group, Inc. or the owners of such software and material. 
 
Process Technologies Group, Inc. assumes no responsibility for any inaccuracies that may be 
contained in the software programs, screen layouts, or other material. In no event will Process 
Technologies Group, Inc. be liable for direct, indirect, special, incidental or consequential 
damages resulting from any defect or omission in this IMPAX TSS SYSTEM, its software 
programs, screen layouts or other material, even if advised of the possibility of such damages. 
Except as otherwise agreed in a license agreement, use of the IMPAX TSS System, software 
programs, screen layouts, and other materials contained herein are AS IS WITHOUT 
WARRANTY INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
 
COPYRIGHT 2002-2009 PROCESS TECHNOLOGIES GROUP, INC. 
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2: Installation 
 
This section explains how to install and configure the IMPAX TSS Viewing System. 
 
2.1: System Requirements 
 
The IMPAX TSS Viewing System requires the following: 
 

Windows 98 Second Edition (Windows 2000 or XP are strongly recommended, due to 
improved DDE support. Windows Vista is not yet recommended) 
Note that Administrator access to the computer may be required. 
 
Microsoft Excel 2000, to run the TSS Viewer 
(Excel XP/2003 or better is strongly recommended, due to increased stability) 
 
Ethernet networking card, to communicate with TSS monitors  
(10 Megabit or faster) 
 
CD-ROM Drive, to load the TSS software from CD 

 
2.2: Installation Procedure 
 
Follow these steps to install the IMPAX TSS Viewing System: 
 
Step 1: Ensure IMPAX TSS monitors are networked correctly 
 
For the Viewing System to display and collect data from TSS monitors, all the monitors must be 
on the same network as the computer running the Viewing System. This means that the monitors 
and computer must be connected by some combination of Ethernet cabling, Ethernet 
hubs/switches, and/or wireless Ethernet bridges. Please ensure that the right type of Ethernet 
cables (standard vs. crossover) are used, according to the specifications of the hubs/switches 
used. Note that the TSS system can share a network with other computers or office equipment, as 
long as each TSS monitor has a unique I.P. address (see below). 
 
Most problems with later installation steps can be traced back to network problems. Please 
ensure that all cables are undamaged and connected correctly. 
 
After the network is in place, the next step is to install the software for the Viewing System. To 
do this, insert the TSS-NET CD into the computer’s CD drive. The TSS-NET Main Menu 
installation program should appear (If it does not, select “Run” from the Start Menu, and type in 
“D:\TSSNETmenu.exe”, where “D” is the letter of the CD drive).
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Note: For the following steps of the installation, administrator access to the computer may be 
required. If your computer is part of a company network, you may need local networking staff to 
give you administrator access to install the software. 
 
Step 2: Install DSDataServer 
 
DSDataServer is the program that will access machine data across the network. Once the TSS-
NET CD is in the computer and the TSS-NET Main Menu has opened, select “Install 
DSDataServer.” The DSDataServer installation program will then run and ask for a Product 
Keycode. Enter the keycode ALWB-7ML8-9UHA-9YKE, and select “Install.” Then follow the 
prompts to complete the installation. When installation is complete, the TSS-NET Main Menu 
should be visible again. 
 
Step 3: Install NetEdit 
 
NetEdit is a program used to configure the monitors’ Ethernet addresses and diagnose any 
networking problems. From the TSS-NET Main Menu, select “Install NetEdit.” The NetEdit 
installation program will then run. Follow the prompts to complete installation. When installation 
is complete, the TSS-NET Main Menu should be visible again. 
 
Step 4: Install TSS-NET 
 
TSS-NET is the Excel-based Viewing System that displays and collects TSS monitor data. From 
the TSS-NET Main Menu, select “Install TSS-NET.” The TSS-NET installation program will 
then run. Follow the prompts to complete installation. When installation is complete, the TSS-
NET Main Menu should be visible again. 
 
Step 5: Install Acrobat Reader (Optional) 
 
Acrobat Reader is an optional PDF reader program, used to read the online versions of the 
IMPAX TSS and TSS-NET manuals. If Acrobat Reader is not already installed on the computer 
(it comes pre-installed on many computers), select “Install Acrobat Reader” and follow the 
prompts to complete the installation. 
 
 
 
When the above steps have been completed, the TSS-NET Main Menu can be closed, and the 
CD may be removed from the CD drive. Several one-time configuration steps need to be done, 
and then the TSS Viewing System may be used. 
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Step 6: Configure Computer Networking 
 
The computer’s network settings should be checked. Network settings can be viewed as follows: 

In Windows XP/2000: In the Start Menu, select Settings, then Network Connections. 
Select the connection associated with the Ethernet card, and click “Change settings of this 
connection.” 
In Windows 98: In the Start Menu, select Settings, then Control Panel. Then select 
Network. 

 
This will bring up a properties window with a list in it. In the list, look for an entry containing 
the phrase “IPX/SPX.” If present, networking is configured correctly: close the window. 
 
If the entry is missing, it can be added to allow for easier networking configuration. It is possible 
to run TSS-NET without IPX/SPX, but you may need installation assistance from IMPAX. Note: 
If your computer is part of a company network, you may need local networking staff to give you 
administrator access to enable IPX/SPX or TCP/IP. 
 
To add IPX/SPX, first click on “Add” or “Install.” Then Select “Protocol” and then “Add” again. 
If using Windows 98, then select the “Microsoft” category. Then look for an entry that contains 
the phrase “IPX/SPX,” select it, and hit OK. Then follow the prompts to complete the protocol 
addition (a reboot may be required). When completed, there should be an entry containing 
“IPX/SPX” in the networking properties window. 
 
Step 7: Configure TSS Network (I.P.) Addresses 
 
Next, the network address (I.P. Address) of each TSS monitor must be configured. To do this, 
open the NetEdit program (installed in step 3) from the Start Menu: Programs -> 
AutomationDirect Tools -> NetEdit 3. In the main NetEdit window, select “IPX” (or “TCP/IP” if 
IPX was not installed) and then “Scan Network.” A list entry should appear for each TSS 
monitor (“Scan Network” may need to be pressed several times. If there is no response, check 
the networking connections). 
 
For each TSS monitor, right-click on its list entry and select “General.” This will open a window 
where the Module ID and the I.P. address can be configured. To use IPX for network 
connections (the default), give each monitor a unique Module ID, between 1 and 255. To use 
TCP/IP, give each monitor a unique IP address beginning with 192.168 (please check with any 
local networking staff to obtain valid I.P. addresses). Then select “OK.” 
 
When addresses have been entered for each monitor, select the protocol being used (IPX or 
TCP/IP) and select Scan Network again. Each TSS should show up again, with the proper 
address. After this, NetEdit can be closed, and should not need to be run again, unless it is 
desired to change monitor Ethernet addresses. 
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Step 8: Configure DSDataServer 
 
After each TSS monitor has been given an address, DSDataServer can be configured to use these 
addresses to collect machine data. Open DSDataServer from the Start Menu: Programs -> 
DirectSOFT 4 -> DirectSOFT32 Data Server Tools -> DirectSOFT32 Data Server. The data 
server will open, after it pauses to scan the network. 
 
After DSDataServer opens, links to the TSS monitors must be initialized. To do this, select 
Setup->Links. Choose to “Add” a new link. Select “Ethernet” and “Next.” On the next screen, 
select “IPX” or “IP,” depending on which protocol is being used (default is IPX). A list of 
networked monitors should appear in the next screen (If it does not, click “Query” several times. 
If there is no response, check the networking connections). Select one monitor and click “Next.” 
The data server should be able to connect to the monitor, and will ask for a Link Name and 
Description. Enter any name, such as “TSS monitor 1,” and select “Finish” to create the link. 
Repeat this process for each TSS monitor that appears in the list. When finished, the “Links” list 
should show all networked TSS’s. 
 
After the links have been set up, exit the “Setup Links” window, and select Setup->Topics. 
Choose to “Add” a new topic. Type exactly “Machine001” as the Topic Name. Then click on 
“Comm Link” and select one of the links. Select “OK” to create the topic. Repeat this process to 
create additional topics for each link, naming them “Machine002,” “Machine003,” and so on. 
 
When this process is complete, DSDataServer has been successfully configured. It should always 
be opened before the TSS Viewer, since the viewer needs the data server to access the TSS 
monitors. 
 
Step 9: Open TSS Viewer 
 
After all of the above steps have been completed, the TSS Viewer may be used. Follow the steps 
in the Section 3.1 below to open the data server, open the Excel-based Viewing System, and 
enable the system’s Excel macros (Excel’s macro security settings may need to be changed, as 
described in the next section). 
 
Once the Viewing System has been opened, machine data should be visible in Excel worksheets. 
Settings such as number of machines and machine names can now be configured, as shown in 
Chapter 6, System Setup. If machine data does not display, or displays as an Excel error (“#N/A” 
or “#REF!”) for more than a minute, make sure that DSDataServer is running. If it is running, 
open it and look at the boxes next to the topics Machine001, etc. These boxes should be green 
when the data server is communicating with TSS monitors. If they are red, yellow, or grey, there 
is a network error. Check the network connections, link settings, and topic names for errors, 
close the TSS Viewer and DSDataServer, and restart them. 
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3: Basic Operation 
 
3.1: Opening TSS Viewer 
 
To open the TSS viewer workbook and its data server, follow these steps: 

1. Run DSDataServer: The default location is in the Start Menu, in Programs -> 
DirectSOFT 4 -> DirectSOFT32 Data Server Tools -> DirectSOFT32 Data Server. 
Wait a moment until the data server has loaded. 

 
2. Run the IMPAX TSS Viewer: The default location is in the Start Menu, in Programs -> 

IMPAX TSS System -> IMPAX TSS Viewer. 
 
3. Select "Enable Macros" when Excel asks whether macros should be run: 
 
 
 
 
 
 
 
 
 
 
 
Note: If Excel does not ask about macros when opening, macros may be turned off. If this is 
the case, the TSS Viewer will not function correctly. 
To ensure macros are enabled, open Excel and go to the Tools menu. Then select Macro, and 
then Security. Ensure that the Security Level setting is set to “Medium (You can choose 
whether or not to run macros).” Excel will need to be restarted after changing this setting. 
 
4. Select "Update" when Excel asks whether data links should be updated: 
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3.2: Closing TSS Viewer 
 
To close the TSS viewer workbook and its data server, follow these steps: 

1. Close the Excel file, by selecting Close or Exit from the File menu, or by clicking on the 
X in the upper-right corner of the window. 
A save prompt will appear, but saving is only necessary if settings were changed: 

 
 
 
 
 
 
 
2. Close the data server, by selecting Exit from the File menu, or by clicking on the X in the 

upper-right corner of the window. 
 
 
3.3: Navigation 
 
When the TSS viewer workbook is open, several 
screens are available, each of which displays 
different data. To change which screen is active, 
use the buttons in the upper-right, or the tabs at the 
bottom of the workbook. The following screens 
are available: 
 
 
 

• Introduction: The screen that the workbook opens with 
• Summary View: A visual overview of all monitored machines 
• Detail View: A detailed look at data from a target machine 
• OEE View: A summary of Overall Equipment Effectiveness 
• Reporting: A screen for generating customizable reports 
• Setup: A screen for setting up machine parameters and data collection settings 

 
Other buttons similar to the main navigation buttons appear on each page. These buttons can be 
clicked to use the viewer's various features, as described in this manual. Many features are also 
available through an "IMPAX TSS System" menu that will appear in Excel's menu bar at the top 
of the screen. For more information on these features, see the section on menu options below. 
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4: Data Viewing 
 
4.1: Summary View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen provides an overview of production information for all monitored machines. Each 
machine is listed in its own row. If there are many machines, the list may be several pages long. 
The scroll bar on the right edge of the screen can be used to scroll through the pages. For each 
machine, the following data is presented: 
 

• Machine Name 
• Machine Status: whether the machine is UP or DOWN, and how long the machine has 

been in downtime (if applicable) 
• Current PPM: current Parts Per Minute 
• PPM Efficiency: a measure of the current PPM, divided by the ideal/target PPM set for 

that machine 
• Current Production: good parts made this shift, divided by the number of parts 

expected this shift (based on target PPM) 
• Today's OEE: current Overall Equipment Effectiveness, calculated in OEE View screen 
• "View Details" button: shortcut to the Detail View screen 

 
There is also a "View OEE Details" button, which is a shortcut to the OEE View screen (see 
below). 
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4.2: Detail View 
 
This screen gives a detailed view of one machine's status. To begin viewing machine details, 
click on the drop-down menu at the top of the page and select a machine. Then wait until the 
machine's details are loaded. Several pages of details will be loaded, the scroll bar on the right 
edge of the screen can be used to scroll through the pages. 
 
The first details listed are the machine's 
Current Status. This section displays 
whether the machine is UP or DOWN, 
what the machine's current RPM, PPM, 
and Scrap are, and what Job, Part, and 
Operator are active on the machine. Also 
listed is any current message entered by 
the machine's operator. The "Send New 
Message" and “View Message Log” 
buttons are available for communication 
with the machine. 
 
The next section of details is 
Efficiencies. The following machine 
efficiencies are displayed: 
 
Instant Efficiencies (calculated each second): 

• RPM Efficiency: Current RPM divided by ideal RPM 
• PPM Efficiency: Current Parts Per Minute divided by ideal PPM 
• Feed Efficiency: PPM divided by RPM, measures how machine cycles translate into parts 

Current Shift Efficiencies: 
• Time Efficiency: Uptime divided by total time 
• Feed Efficiency: Parts made divided by machine cycles, measures how well machine 

cycles translate into good parts 
• Cycle Efficiency: Machine cycles divided by cycles expected (calculated using ideal 

RPM) 
• Parts Efficiency: Parts made divided by parts expected (calculated using ideal PPM) 

Daily Efficiencies (listed for all shifts and for the day): 
• Time Efficiency: Uptime divided by total time 
• Feed Efficiency: Parts made divided by machine cycles, measures how well machine 

cycles translate into good parts 
• Cycle Efficiency: Machine cycles divided by cycles expected (calculated using ideal 

RPM) 
• Parts Efficiency: Parts made divided by parts expected (calculated using ideal PPM) 
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The next section of details is Up/Down 
Times. Totals are maintained for 
Uptime, Downtime, and Response Time. 
These totals are shown for all shifts and 
are totaled, and are also shown for the 
current day, week, month, and year. Note 
that this historical data is based on the 
historical totals kept in the TSS, not on 
the collected machine data kept in data 
files on a PC (See Data Collection below 
for more details). 
 
 
 
 
The next sections of details are for 
counts. The first section, Production 
Counts, shows current data from the 
Order Counter, as well as production 
counts for all shifts (and totals), for the 
current day, week, month, and year. 
 
The following sections show current data 
for all Tool Counters and Maintenance 
Counters being used at the machine. 
Drop-down menus in these sections 
provide a way to automatically color 
counters yellow or red, based on how 
close they are to their “expected life” 
values. Standard percentages can be  
selected in these drop-down menus, or  
custom values from 1 to 100 can be  
typed in manually. 
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The next section of details is Downtime 
Reasons. This section lists the number of 
occurrences (Occur) and total time in 
minutes (Time) spent in downtime. 
Number of Occurrences and Time totals 
are shown for the current day, week, 
month, and year. Data for downtime 
reasons 1 through 16 is shown by 
default; to view data for reasons 17-32, 
33-48, or 49-64, click on the drop-down 
menu next to "Show Codes" and select 
the reasons of interest. The new set of 
reasons will then load. 
 
 
 
 
The final section of details is Downtime 
Occurrences. This section lists the 
Downtime Log entries from the TSS, 
which record each instance of downtime. 
Data for the last 8 downtime occurrences 
is shown by default; to view data for 
previous occurrences 9-16, 17-24, or 25-
32, click on the drop-down menu next to 
"Show Occurrences" and select the ones 
of interest. The new data will then load. 
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4.3: OEE View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen displays calculations of current Overall Equipment Effectiveness (an efficiency 
metric) for all machines. Based on data from the machine, OEE is calculated continuously. 
 
OEE is based on three percentages, which are calculated based on machine data: 

• Today's Scheduled Time: total time in minutes allotted for today's schedule 
• Today's Downtime: total time spent down today 
• Today's Available Time: the difference between Today's Scheduled Time and Today's 

Downtime 
• Availability Percent: Today's Available Time divided by Today's Scheduled Time, 

represents how available the machine has been for production 
• Today's Parts Made: total good parts produced today 
• Ideal PPM: the ideal/target PPM set for the machine 
• Performance Percent: Today's Parts Made divided by Today's Expected Parts (which is 

the Ideal PPM times Today's Available Time), represents how many parts a machine has 
made compared with how many it should have made 

• Today's Scrap Parts: total bad parts produced today (note that this requires custom 
programming for each machine, and will otherwise be zero) 

• Quality Percent: the difference between Today's Parts Made and Today's Scrap Parts, 
divided by Today's Parts Made, represents the quality of production. 

 
Overall Equipment Effectiveness is then calculated by multiplying the three percentages. OEE 
sums up the machine's availability, performance, and quality. OEE starts at zero each day, and 
works its way up towards 100% at the end of the day (assuming production remains on target). 
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4.4: Menu Options 
 
Many features are available through the "IMPAX TSS System" menu that will appear in Excel's 
menu bar at the top of the screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
Copy selected data to a new book 
 
This feature is only available through the menu. When selected, this function copies any data 
currently selected, creates a new workbook, and pastes the data there. This is useful for running 
an analysis or making a graph based on the data, without interfering with the TSS system. 
 
Send Message to Machine / Message Log 
 
These message-sending features are explained in the System Setup section below. 
  
System Setup 
 
The features in this sub-menu are explained in the System Setup section below. The "IMPAX 
System Setup" option is for IMPAX engineering use only. 
 
About TSS Viewing System 
 
This option displays information about the TSS Viewing System, including version information, 
contact information for IMPAX, and the user notice. 
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4.5: Printing 
 
All screens with machine data have a "Print this Page" button. Clicking this button will put Excel 
into Print Preview mode and format the page for printing. From Print Preview mode, the page 
can be printed by clicking "Print..." Once the screen is printed, "Close" can be clicked to return 
to the data screen. 
 
For example, pressing the print button on the Summary screen will format the screen for 
printing: 
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5: Data Collection and Reporting 
 
5.1: Overview 
 
In addition to viewing daily, weekly, monthly, and yearly data from connected TSS monitors, the 
TSS Viewing System also supports data collection to PC. Machine data can be collected 
periodically from all machines, and can be recorded on the local PC to create a historical record 
containing all machine data. 
 
Several types of data can be collected: 

• Machine History Data: The record of all production, uptime, and downtime experienced 
by each machine each day 

• Downtime Occurrence Log: The daily log of downtime occurrences 
• Part and Operator Data: The record of production for each session (a session is a 

combination of job number/part number/operator ID) 
 
This data is periodically collected from all machines, and saved to files on the computer's hard 
drive. Machine history data and downtime occurrence logs are saved once per day. Downtime 
occurrence logs are also saved when the log fills up on any machine. Part and operator data are 
saved whenever a new job number, part number, or operator ID is entered into a TSS. Each TSS 
has memory buffers to hold this information until it is collected, but the PC must be able to 
connect to each TSS at least once a day to collect data, or data will be lost. 
 
5.2: Data Collection Settings 
 
Several settings control how data is collected. 
These settings can be changed through the 
System Setup screen, in the lower-right corner. 
Clicking the "Setup Data Collection" button 
will bring up a window where the settings can 
be changed. Data collection for daily data 
(machine history data and downtime logs) and 
for parts/operators can be turned on or off. 
Also, the folder where the data files will be 
saved can be customized (This folder can be on 
the local PC, like “C:\Data”, or a network 
shared folder, like “\\Server123\Data”). Note 
that these settings are saved in the Excel workbook, so that if they are changed, the workbook 
should be saved by selecting "Save" from the "File" menu afterwards. 
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The area of the System Setup screen under 
the data collection settings is a message 
display area to report on the status and 
progress of saving data. Whenever any 
saving is turned on or off for a machine, 
and whenever a set of data is saved, a 
message will display here. Any errors 
encountered will also be displayed here. 
 
 
5.3: Saved Data Files 
 
Saved Data is automatically placed in files called "SavedPartsAndOperators.csv", 
"SavedDailyData.csv", and "SavedDowntimeLog.csv" in the directory specified by the data 
collection settings. These files are in comma-separated/comma-delimited values format. The first 
line of each file contains descriptive headers, and each following line contains data for one saved 
job/part/operator, day from one machine, or downtime occurrence. The files can be opened in 
any text editor or Excel, but copies should be made for editing or they should be opened as 
"Read-only" if the TSS Viewing System is still running, so that the system is able to save any 
new data. The files can also be safely deleted or moved to an archive folder at any time the 
system is not saving new data; the system will start over with a new blank file. 
 
 
5.4: Generating Reports 
 
Reports can be generated based on the saved data files, using the Reporting Screen. To generate 
a report, click on the "Generate New Report" button, and a window will appear with the 
following options: 
 
Choose which data to report on 
Reports can be based on either machine history data, downtime occurrence logs, or part/operator 
data. Which data type is chosen may determine which reporting options are available. 
 
Choose dates to be included in report 
Data for the reports is filtered by the chosen start date and stop date: only data between the two 
dates is shown. Dates may be entered in MM/DD/YYYY format or in any Excel date format. 
 
Choose dates to be included in report 
Data for the reports can be filtered by machine. If filtering is used, only data from the selected 
machines is shown. Press “Select Machines” to bring up a menu for selecting machines to use. 



IMPAX TSS-NET Manual  Version 2.31, August 2009 
 

 Page 19 

Choose format of report 
Two types of reports can be generated: list reports and summary reports. List reports list all data 
records that match the date filter, and are good for looking at or sorting all data records. 
Summary reports combine the data records to generate totals, and are good for looking at 
summaries of aggregate data. 
 
Choose order to sort listed records 
or to group summarized records 
Report data is sorted (and optionally 
sub-sorted) by the chosen categories. 
Entries in a list report are simply 
sorted. Entries in a summary report are 
sorted by the chosen category, and 
grouped by that category to produce 
totals. 
 
Choose data fields to list or 
summarize 
The data fields chosen here are the 
ones that will form the actual data of 
the report. Which data fields are 
available is determined by the other 
report settings. 
 
Once the desired settings are entered, 
clicking on "Generate Report" will 
save the settings and build a new 
report based on the chosen options. 
The report will then appear in the 
Reporting Sheet. From there, it can be 
viewed or printed (using the "Print this 
Page" button). The report is current as of the moment it was generated; it will not update as new 
data is collected. The Reporting screen can be cleared by using the "Clear Report" button. 
 
When a report is generated, the IMPAX header and navigation buttons may be temporarily 
distorted due the columns being resized. This is a known Microsoft-acknowledged bug. 
 
Note that reporting settings and the current report are saved in the Excel workbook, so they will 
only be kept if the workbook is saved (select "Save" from the "File" menu to save). 
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6: System Setup 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The System Setup screen allows access to the settings that control the TSS Viewing System, and 
to settings for the networked TSS monitors. These settings can be accessed by clicking on the 
appropriate buttons. 
 
6.1: Editing Machine Names 
 
The names that are used to refer to machines can be edited by 
clicking the "Edit Machine Names" button. A window will 
appear allowing name entry for each machine. 
 
Each name should be unique, to help distinguish them and so 
that their data is unique when saved to disk. Also, machine 
names should not be changed after they are initially set, 
because collected data is stored based on machine names. 
 
The number of machines can also be changed by choosing a 
new number, and pressing the “Change Number of 
Machines” button, in case additional monitors are installed. 
 
When machine names have been entered, click "OK" to save 
them. Note that the names are saved in the Excel workbook, 
so that if they are changed, the workbook should be saved by 
selecting "Save" from the "File" menu afterwards. 
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6.2: Editing Machine 
Settings 
 
The settings that control each TSS 
monitor's operation can be viewed 
and edited by clicking the "Edit 
Machine Settings" button. This 
will bring up a window for the 
TSS settings. 
 
To view the settings from a 
machine, select the machine from 
the drop-down menu in the upper-
right. Then click on "Load from 
Selected Machine." The TSS 
Viewing System will then load the 
settings, and after a few seconds 
they will display. Settings can then be viewed or changed. Help on what the various TSS settings 
mean is available: click on "Help With These Settings" to bring up a window with explanations 
of each setting and valid values for all settings. 
 
Settings will not be saved back to any TSS unless one of the "save" buttons is clicked. To save 
settings, select the machine to save to from the drop-down menu, and click on "Save to Selected 
Machine." Or, click on "Save to Multiple Machines" to bring up a window that will allows 
saving to more than one machine at once. Once a message window appears to confirm the save, 
clicking on "Done Editing Settings" will close the window. 
 
 
6.3: Editing Downtime Reasons 
 
The downtime reasons used at each 
machine can be edited by clicking the 
"Edit Downtime Reasons" button. The 
will bring up a window containing fields 
for all downtime reasons. 
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To view the downtime reasons for a machine, select the machine from the drop-down menu in 
the upper-right. Then click on "Load from Selected Machine." The TSS Viewing System will 
then load the reasons, and they will display as they are loaded. Reasons can then be viewed or 
changed. Reasons can also be copied to a temporary buffer by clicking "Copy," and then pasted 
back by clicking "Paste." To clear the downtime reasons, click "Clear." 
 
Downtime reasons will not be saved back to any TSS unless one of the "save" buttons is clicked. 
To save reasons, select the machine to save to from the drop-down menu, and click on "Save to 
Selected Machine." Or, click on "Save to Multiple Machines" to bring up a window that will 
allows saving to more than one machine at once. Once a message window appears to confirm the 
save, clicking on "Done Editing Reasons" will close the window. 
 
6.4: Setting Machine Clocks 
 
The clocks of each networked TSS monitor 
can be set by clicking the "Edit Machine 
Clocks" button. The will bring up a 
window with fields for the time and date. 
 
To view the current time/date set at a 
machine, select the machine from the drop-
down menu in the upper-right. Then click 
on "Load from Selected Machine." The TSS Viewing System will then load the clock values, 
and after a few seconds they will display. Values for the time and date can then be viewed or 
changed. The clock values can also be copied from the current PC clock time by clicking "View 
Current PC Time." 
 
No TSS clock will be set unless one of the "save" buttons is clicked. To save the clock values, 
select the machine to save to from the drop-down menu, and click on "Save to Selected 
Machine." Or, click on "Save to Multiple Machines" to bring up a window that will allows 
saving to more than one machine at once. Once a message window appears to confirm the save, 
clicking on "Done Editing Clocks" will close the window. 
 
6.5: Setting Machine Schedules 
 
The schedules used by each networked TSS monitor can be reviewed and edited by clicking the 
"Edit Start/End Times" button. The will bring up a window with fields for a weekly schedule. 
 
To view the current weekly schedule for a machine, select the machine from the drop-down 
menu in the upper-right. Then click on "Load from Selected Machine." The TSS Viewing 
System will then load the schedule, and after a few seconds it will display. Shift start times, end 
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times, and total work minutes are shown for all three shifts, and the whole day, for each day of 
the week. The schedule can be changed by entering new time values for each day of the week, 
and/or for the current day. Refer to the section below for information on editing the times. Times 
can also be copied and pasted: individual days can be copied and pasted into other days, or the 
entire schedule can be copied/pasted across machines, via the "Copy"/"Paste" buttons. 
 
Work minutes and total work minutes can also be entered. These values represent the total 
amount of available minutes in each shift of the indicated period. This is used for calculating 
percentages and efficiencies by TSS monitors. They can be calculated automatically (if 
"Automatically Calculate Work Minutes" is checked), manually by clicking on "Calculate Work 
Minutes," or they can be entered by hand. 
 
No TSS schedule will be saved unless one of the "save" buttons is clicked. To save the schedule, 
select the machine to save to from the drop-down menu, and click on "Save to Selected 
Machine." Or, click on "Save to Multiple Machines" to bring up a window that will allows 
saving to more than one machine at once. Once a message window appears to confirm the save, 
clicking on "Done Editing Times" will close the window. 
 
Tips for Editing Machine Schedules 
 
Shift start times, end times, and total work minutes are shown for all three shifts, and the whole 
day, for each day of the week. Times are grouped by day of the week, with the current day's 
times listed after Saturday's times. When a day ends, the next day's times are loaded and placed 
into the Current Day times. Times are also loaded whenever the monitor is turned on. 
  
Start/End times should be set carefully! The monitor will only record data when the current 
time is within the defined daily period AND within a shift period. Anything that happens outside 
of these windows will be ignored. If times are set incorrectly, data loss/corruption can occur. 
 
All times are in 24-hour time: hours range from 0-23, and minutes range from 0-59. The time 
0:00 is 12:00am, and 23:59 is 11:59pm. To enter the daily period, enter the hour and minutes for 
the Day Start Time and the Day End Time. The daily period will last from the first second of 
Day Start Time to the last second of Day End Time. For example, a 10:00am to 4:00pm shift 
should be entered as 10:00 to 15:59. The Day Start Time should be less than the Day End Time, 
unless the daily period goes through midnight. For example, a 10:00pm to 4:00am shift would be 
22:00 to 3:59. No day may last more than 24 hours. Adjacent days should not overlap. Note: if 
the daily period is set to begin at or after 18:00 (6:00pm), the day will actually begin at that time 
on the previous calendar day (a Day Start Time of 22:00 will start the previous day at 10pm). 
 
Shift start and end times are entered similarly. Shifts can go through midnight, but should not go 
through the start or end of the daily period. All active shifts should fall within the daily period. 
Two shifts should not overlap. A shift can be turned off by setting its start and end times to 0:00. 
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A sample schedule is shown below, in which Monday-Thursday are 24-hour days with three 8-
hour shifts, Friday is a 20-hour day with two 10-hour shifts (where shift two goes through 
midnight), and Saturday and Sunday are disabled. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Disabling Days 
 
A day can be disabled by setting its start and end times to be equal. This will turn off all 
uptime/downtime monitoring on that day. Even when a day is disabled, the TSS checks for the 
start of a week/month/year at that day's start time. This means that disabled days' times should be 
set so that no day is skipped. For example, if Friday's shifts run until 1:59am Saturday morning, 
Saturday's start and end times should be set to 02:00 or later so that if Saturday starts a new 
month, monthly data will be reset correctly. For another example, if Monday's shift 1 starts at 
10:00pm Sunday night, Sunday's end time should be set earlier than 10:00pm, so that Monday's 
times can be loaded correctly.
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6.6: Editing Pending Parts 
 
Each machine can 
have up to four 
pending parts, which 
are records for part 
jobs that have not yet 
started, but that an 
operator can start with 
the press of a button. 
The pending part 
records can be edited 
by clicking the "Edit 
Pending Parts" button. 
The will bring up a 
window containing 
fields for all four 
pending parts. 
 
To view the pending parts for a machine, select the machine from the drop-down menu in the 
upper-right. Then click on "Load from Selected Machine." The TSS Viewing System will then 
load the fields, and they will display as they are loaded. Fields for each pending part can then be 
viewed or changed. All the fields can also be copied to a temporary buffer by clicking "Copy," 
and then pasted back by clicking "Paste." To clear the fields, click "Clear." 
 
Pending parts will not be saved back to any TSS unless one of the "save" buttons is clicked. To 
save parts, select the machine to save to from the drop-down menu, and click on "Save to 
Selected Machine." Or, click on "Save to Multiple Machines" to bring up a window that will 
allows saving to more than one machine at once. Once a message window appears to confirm the 
save, clicking on "Done Editing Pending Parts" will close the window. 
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6.7: Viewing and Sending Messages 
 
Messages can be sent to and from 
machines through the messaging 
interface. Messages can be viewed 
and sent by clicking the "View 
Message Log" button. The will 
bring up a window showing the 
message log. 
 
To use the log, ensure it is enabled 
(Click “Enable Message Logging” 
and then “Apply” or “OK.” Once 
enabled, messages sent to 
machines and received from 
machines will be displayed in the 
log. The log automatically updates 
periodically; to force an 
immediate update, click the 
“Check for new messages now” 
button. The log can be cleared by 
pressing the “Clear Message Log” 
button. 
 
Note that the message log and 
settings are saved in the Excel workbook, so if they are changed, the workbook should be saved 
by selecting "Save" from the "File" menu afterwards. 
 
 
New Message Notification 
 
To receive notification whenever a new 
message is received even when the log is 
not active (such as when another screen 
is being viewed), click “Enable New 
Message Notification” and then “Apply” 
or “OK.” Now, when the message log is 
closed, a notification window will appear 
whenever a new message is received. 
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Sending Messages 
 
To send a message to a machine, press the “Send New 
Message” button (or one of the other send message buttons 
throughout the TSS Viewer). This will open the Send 
Message window. To send a message, first select which 
machine(s) to send the message to (use "Send to Multiple 
Machines" to send to more than one machine). Then enter 
the desired message (limited to 20 letters/numbers). Then 
press "Send Message" to send the text to the chosen 
machines (if "Send to Multiple Machines" was selected, a separate window will appear for 
selecting which machines to send to). The message will then be sent to the TSS Monitor(s), and 
displayed for the operator(s). The message will also be entered into the message log, if message 
logging is enabled. 
 


